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This guide should provide answers to most questions that you might have about setting up your

computer and taking online exams.

If you need further assistance please call us at 1-888-553-5333.

Guide to Online Exams

5/25/2011

Page 2 of 16



Setup Steps At A Glance

. .

.
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Set Regional Settings To US English

Log In To The Student Resource Center
Set Privacy and Security Settings In Internet Explorer To Medium
Ensure Pop-Up Blocker Is Turned Off
Review The Online Exam Tutorial

Test Your Internet Connection To The Marking Server
. Take And Submit Your First Exam

Setup Assistance Step By Step

Step 1. Regional Settings Must Be Set To US English

In order to access the resource center and all its associated materials as well as the final exams for your
course, you will need to ensure that your computer's regional settings are set to US English. To do this, go
to "Control Panel" and click on the "Regional Settings" item. Select English (United States) from the

dropdown box.

| Regional and Language Options

Current format:

=

To change the way your computer displays numbers, currencies, dates, and
time, select an entry from the format list.

English (United States)

Mumber:
Currency:
Time:
Short date:

Long date:

123,456,789.00
§123,456,789.00
11:25:20 PM
3/13/2011

Sunday, March 13, 2011

Examples of how data is displayed using this format:

Customize this format...

For additional formats, keyboards, and tools, go to the Microsoft website,
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Step 2. Logging in to the Student Resource Centre

In order to take a final exam online or access additional course materials, you will need to visit the
“Distance Education Technical Training” website and log in to the student “Learning Resource
Centre” web page. To do this, you will need the following information which has been previously sent to
you in your registration confirmation email notification. If you did not receive the confirmation email
providing this information, please contact us at 1-888-553-5333.

Distance Education Technical Training website address:
Login:

Password:

Go to the designated website and enter your Login and Password information to log in.

Distance Education
Technical Training

Hame About | Cerificates | FAQ Testimonials | Regisiration Cosis | Confact

TECHMNICAL TRAINING

chanical Technician

Ron Storvick | Chan ed My Future
Training Coordinator .
Boeing Acrospace With A Career In Technology
Distance Education What's New Tuition Assistance  Request Your FREE
Technical Training _ ) Information Package
e DD version of ET & | S'eleél a Bﬁrﬂmtﬁr
Study atyaur awn pace, In EM now available » - ‘% D'E U = i
the comifort of your own Interactive Discussion N ‘./ = lgél:_tn;lht;E.
hiorne, with these easy-to- Forums » - - D. Electrotmechanical
use somputer-based ET Adapts CircuitLogi Learn ahautour [IpLe
fraining pragrams and Simulation » Ray-as-yau-ga program VOME e oEACLIDFOT AT

develop your gualifications Mew 3rl s ditian of PLE

eyl gt texthook is nowe available w
technology, Emai

IR A

ffirst name last name

Thfsfree no D:'b[.lgaf. acka
be emafledto -;mu w.uthm 2411=ou|‘5
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Once you have logged in, you will be brought to the “Learning Resource Centre” web page. This is the
site from which you will access the various online resources provided for use with the distance learning
technician certificate programs. To access the available resources, links appear down the left hand side of
the web page. Double click on the link to start up the desired resource.

TECHNICAL TRA

Home

yolent Forum
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Distance Education
Technical Training

Welcome to the Electronics Learning Resource Center

Congratulations on your decision o enroll in our distance education
technical fraining program. The Online Learning Center provides a variety
of learning resources and testing services for students in the Electronics
program.

These links provide additional related course content to assist you inyour
studies and preparation for final exams. You will find extra content, shart
wideo clips, hands-on demos, challenge guestions and brainteasers far
each module ofthe course as well as a glossary and the image library.

Youwill also have access to the final exam for each module. Secure access to our online testing server
is alzo provided through these pages. Please review the Exam Tutorial hefore you attermpt the first
maodule final exarm.

Join our Online Discussion Forums 0
Share your comments, questions and experiences with )

other students, ask our oniine tutor course related !
questions or find cut about the latest program )
announcements though the interactive Student Forums. 4
Just click here to link to the Forum page p b 24
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Step 3. Internet Explorer Settings

You will need to modify your “Security” settings in Internet Explorer. Click on the “Tools” menu. Next,
click on “Internet Options”. Then select the “Security” tab. Set the slide bar to “Medium”. Click

“Apply”-

Internet Options i

|_ General-l Security | Privacy | Content | Connections | Programs | Advanced |

Select a zone to view or change security settings,

Internet Local intranet  Trusted sites  Restricted
sites

Internet

g This zone is for Internet websites, Sites
except those listed in trusted and

restricted zones.

Security level for this zone
Allowed levels for this zone: Medium to High

{ Medium

{ - Prompts before downloading potentially unsafe
content
- Unsigned ActiveX, controls will not be downloaded

[7] Enable Protected Mode (requires restarting Internet Explorer)
| Custom level... | | Default level |

I Reset all zones to default level |

o J[ concd J[ ooy |

Next, click on the Privacy tab and set the privacy slide bar to Medium and then click Apply button. If
your window looks like the one below, click on the Turn Off Pop Up Blocker checkbox. You can then skip
the next step listed below. If you do not have a setting for the Pop-Up Blocker on the Privacy tab, just click
“OK” and follow the instructions in the next step to turn off the Pop-Up blocker.
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Trtenet Ophions
General I Security | Privacy |Eontent I Connections | Programs I Ad-.rancedl

Settings

Select a setting for the Internet zone.,

i Medium

- Blocks third-party cookies that do not have a compact
privacy policy
- Blocks third-party cookies that save information that can
oo be used to contact you without your explicit consent

- Restricts first-party cookies that save information that
‘ can be used to contact you without your implicit consent

[ Sites I [ Import ] ’ Advanced -E_;Efe;ult |
Pop-up Blodker
@ Prevent most pap-up windows from [ Settings
- appearing.
[] Turn on Pop-up Bladker
InPrivate

;13 [ Do net collect data for use by InPrivate Filtering

— Disable toolbars and extensions when InPrivate Browsing
@ starts

o J[ concel [ ewply |

Step 4. Turn Off Your Pop-Up Blocker

Go to the Tools menu, and click on the Pop-up Blocker menu item, Click on Turn Off Pop-up Blocker

(78

Re

Turn Off Pop-up Blocker
Pop-up Blocker Settings

Pop-up Blocker

Manage Add-ons

monials | segistrauon | Gosts

Wark Offline

Compatibility View

Compatibility View Settings

[=A] Full Screen F11
Toolbars 4

Explorer Bars »
| <y Developer Tools F12
Suggested Sites

Send to OneNote

Vith A Career In Technol

Internet Opticns
!
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You will need to turn off the Pop-up Blocker in your Internet Explorer web browser application so that
the Active X script can be run.

Step 5. Review the Online Exam Tutorial

Return to the Learning Resource Centre web page. Making sure your Pop-up Blocker is turned off,
double click on the link for the “Exam Tutorial” from the list of links located on the left hand side of the
Learning Resource Centre web page. A new tab/window will open containing the exam tutorial. Go
through the slides in the tutorial to get an idea of the process which will be used for writing your exam
online. The tutorial will only take a few minutes. It is strongly recommended that you take the time to go
through it before attempting to write your first exam. The slides are not live, but rather are screen captures
of the dialog boxes you will encounter when going online to write your exam. Use the “Next”, and “Back”
buttons to navigate through the tutorial. While going through the tutorial, you are informed that you will
need to install the applet for Active X Controls. You will be prompted to install this applet each time you
take an exam online. In addition, you will be prompted to do a connection test each time you take an online
exam.

Distance Education
Technical Training

fECHNICALTERRI Welcome to the Electronics Learning Resource Center

Home Congratulations an your decision to enrall in our distance education
' technical fraining program. The Online Learning Center provides a variety
of learning resources and testing services for students in the Electronics
program.

These links provide additional related course content to assist you inyour
studies and preparation for final exams. You will find extra content, short
it Form wideo clips, hands-on demos, challenge guestions and brainteasers far
each module ofthe course as well as a glossary and the image library.

Youwill also have access to the final exam for each module. Secure access to our online testing server
is alzo provided through these pages. Please review the Exam Tutorial hefore you attermpt the first
module final exam.

m Tutoral

Join our Online Discussion Forums .
Share your comments, questions and experiences with | |
other students, ask our oniine tutor course related
questions or find cut about the latest program
announcements though the interactive Student Forums.
Just click here to link to the Forum page p
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Step 6. Test your connection to the marking server

Once you have reviewed the Exam Tutorial, you are ready to test your connection to our marking server.
From the list of links on the left hand side, select the link marked “Final Exams”. Do not worry if you are
not ready to write your first online exam, we will only be checking the connection to the marking server at
this time. We wish to ensure that your setup is correct, and that you can communicate with the marking
server. When you are actually ready to take the exam, this connection test will ensure that your exam
submission will be received. From the “Learning Resource Centre” web page, select the “Final Exam”
link on the left hand side of the page.

Distance Education OMLIE RESOURCE CENTER
Technical Training S

TECHMNICAL TRAINING Final Exams

Haifme Congratulations, you're ready to write a Final Exam.

i~

The farmat of the exam is as follows:

& 90 minutes to complete the exam
e 30 guestions
cent Farum e« Multiple-choice and short-answer

Before You Begin

« Complete the practice test for this module.

¢ Ensurethe CO ROM program is installed on your caomputer.

&« Have your student name and student ID humber ready.
Be sure a Microsoft Exchange or Micrasoft Outlook email accountis set up on your machine OR
you have a floppy disk ready to save vour completed exarn.

« He surewou are using Internet Explorer as your browser.

Far more information click on EXAM FAQ

Howe to take an exam
This tutorial will guide you through the steps required to access your exams.

Are you are ready to start the exam? Click Select Exam Module to select your module.

Select Exam Module

Image Likrary
" " \

Click on the “Select Exam Module” link at the bottom of the Final Exams page. You will now see a list of
modules for which you have been registered. You will find the available module exams under the
“Registered” heading. Select the desired module exam you wish to take. As we are only checking our
connection and not actually writing the exam, it does not matter which module we select at this time.

At this point you should be prompted to “Install Active X Controls”. Click on “Yes” and install the
Active X Controls for the selected exam module. Be sure to check your toolbar to see if the pop up prompt
to install Active X Controls appeared. If you do not receive the prompt, double check the status of your
Pop-up Blocker, ensuring that it is turned off. If problems persist, your security settings may be affecting
the installation of the “Active X Controls” applet. By default, Internet Explorer’s security settings
regarding Active X Controls are set to “Enable”. If the pop-up prompting installation of the Active X
Controls applet does not appear, you will need to modify the “Security” settings in your browser.

If your security, privacy and pop-up blocker settings are all correct and you are still unable to get the pop-
up to install the exam, you may need to delete your browser cache to clear any previous attempts at

Guide to Online Exams 5/25/2011 Page 9 of 16



downloading the exam applet. To do this, go to your Internet Options menu item under the Tools menu in
Internet Explorer and select the Delete button. Be sure to delete cookies, and all temporary internet files
and offline content.

TInternet Options [ 7 ||
General |Security i Privacy | Content I Connections E Programs. i Aduanaedl

Home page

4” To create home page tabs, type each address on its own line,

L] .

i http://ca.yahoo.com/ .
| Jse current | I Use default ] | |Use blank

Browsing history

A, Delete temporary files, history, cookies, saved passwords,
¥ and web form information,

[¥] Delete browsing history on exit

| Celete,.. “ Settings l

Search
:': j Change search defaults, | Settings |
7
Tabs -
. Change how webpages are displayed in Settings |
tabs.
Appearance
Colors | [ Languages I I Fonts ] [ Accessibility ]

Looc J| cencel [ oot |

Once you have selected an exam module and installed the Active X Controls applet, the following dialog
box will appear.

W] Electianies Technician Exam - Module 01 23|}

I.-"'_ "-.I This is a Timed 90 minute Exam! There are 30 Questions. You can
W submit the examn over the Internet, or as a backup, save a copy. Do you
want to write the exam now?

Click on the “Yes” button to continue. Again, do not worry, we are not actually going to take the exam at
this time, these steps are required to confirm your ability to submit the exam over the internet. You will
now be prompted to enter your student name, ( this will be the name you used to log in to the site ) and
your password.

Guide to Online Exams 5/25/2011 Page 10 of 16



You will now be asked if you wish to test your internet connection to the marking server. Select “Yes”.

—-%

Electronics Technician Exam - Module 01 EE

I.-"'_""-.I This is an Electronics Technician Bxam. Your Test Answers can be sent
W' to our Marking Server over the Internet.

As a back up, your test answers can also be saved and sent to our
Student Support Centre by email.

Would you like to test your Internet connection?

1=
m
1

If you have set up your computer correctly, you will send a query to the marking server. The marking
server will send a reply advising if the connection test was successful or if it failed.

7| Electronics Technician Bxamr - Module 01 =

The Metwork Test message has been successfully sent.
You should get confirmation E-Mailed to you by the Marking Server within a few
minutes,

To now take a final exam, re-enter the Final Exarn module from the beginning.

Click the “OK” button and you will be returned to the “Final Exams” module selection page.

If you encounter difficulties with the connection test, you will receive the message shown below. This
message may appear if your connection to the internet is not working or your firewall is blocking
communication. It may also appear if you are using a proxy server.

. Connection Test Problem

The MNetwork Test program was apparentty unable to send thie test
message back to the Marking Server. [ this is atemporany netwark
problem, please press Betry. [fyour computer uses a Froxy Serser,
please choose the Proxy Servser button. Altermatively, you could sawve
the exam to a disk drive, atthe end of the exam. To now take afinal
exarn, please re-enter the Final Exam module from the beginning.

L e Browy Server Cencel
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You can check that your internet connection is working, and then use the Retry button if the problem was
with your modem or connection cables. If you have a proxy server, you will need to click on the button
shown and enter the proxy server name into the dialog box shown below. This dialog box comes up when

you hit the Proxy Server button.

Examn Error - Try Prowy Server

The Metwork Test program was apparently unable to
zetd the test meszage back o the Marking Server.

If your computer uzes & Proxy Server, please enter its
nare, and press OK

The name of your Prosy Server might be inthe Control
Farel | Internet Options | Connections | LAM Settings

Alternatively, pou could save the exam on pour
computer, at the end of the exam.

Pleaze run the esam again when pou are ready bo write
it.

It an exam cannot be sent, please contact the Student
Support Center toll-free at 1-2833-553-5333

=3

Cancel

f

If you were using a proxy server, once you enter the server name, the connection test can be retried and the

error should be resolved.

If you still cannot resolve the problem, you will need to hit the Cancel button. You can still take the exam
by returning to the Final Exams page and selecting the desired exam module, however, you will need to
save the exam to disk and email it to us for grading. That option will be provided after you complete the

cexam.
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Step 7. Take your first Exam and submit it for evaluation.

It is recommended that you check your internet connection as part of the process every time you go online
to write a final exam. This means that you will repeat Step 6 above, each time you go to write an exam.
Once your ability to connect to the marking server has been confirmed, you will be returned to the

Resource Centre. You will need to select the “Final Exams” link again. Click on the “Select Module” link
and choose the desired final exam to take. Click on the desired exam and you will be prompted to install
Active X Control exam applet for the selected module. Once you have installed the Active X Control applet,
you will be provided with the following sequence.

/E! Electronics Technician Exam - Module 01 izl

' submit the exam over the Internet . or as a backup, save a copy. Do you
want to write the exam now?

'g This is a Timed 90 minute Exam! There are 30 Questions. You can

........................................

You have already seen this dialog when we did the internet connection test. Click the “Yes” button and you
are prompted for your student login information.

Student Mame

Please enter your hame:
Cancel

Password

Please enter your Passwarnd:
Cancel

Enter the required information and click the “OK” button for each of the above.
You will then be prompted to do an internet connection test. This time, click on the "No" button as we have
already tested your ability to submit the exam to the marking server.
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Electronics Technician Exam - Module 01 Z3

I.-"'_ | This is an Electronics Technician Exam. Your Test Answers can be sent
| to our Marking Server over the Internet.
~ Asaback up, your test answers can also be saved and sent to our
Student Support Centre by email.

Would you like to test your Internet connection?

........................................

You will then be brought into the Final Exam you selected and your 90 minute time limit will begin.

Once you have completed the 30 Exam Questions, you click on the “Exit” button from the exam. You will
be asked if you wish to submit your exam over the internet. Click “Yes” and your exam will be
automatically sent to the marking server for evaluation. You will be advised that the submission was
successfully sent.

& | Electronics Technician Bxam - Module 01 A,

I'e:l Are you sure you are ready to Save and Exit the Bxam?

% | Electronics Technician Eam - Module 01

The Exarn has been successfully sent.
Your Exarn results should be E-Mailed to you by the Marking Server within a few
minutes.

........................................

Selecting No will allow you to save the exam file to disk. You can then email it to us to have it graded.
This process takes longer, but if you were unable to complete the connection test, you will need to save the
exam to disk, and email it in.
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If you select Yes to submitting the exam over the internet, and a problem getting the exam submission sent
occurs, you will see the dialog box shown here instead of the confirmation dialog shown previously.

3. Exam Mebwork Problem

The Exam program was apparently unahble to send the test message
back to the Marking Server. If this is atermporany network problem, please
press Retry. [fyour computer uses a Proxy Server, please choose the
Froxy Server buttan. Alternatively, you could save the exam to a disk
drive. Flease attach the exarm file to an email to the Technical Training
Distance Learning Student Support Center itoll-free 1-888-553-5333).

Pro=p Server Save File

You are presented with three options. The first option can be used if you have found an issue with your
modem, or internet connection and resolved it. Click Retry, and a second attempt at submitting the exam
will be made. If you are using a proxy server, you will need to click on the Proxy Server button and enter
the server name. If neither of these two items resolves your issue, you will need to click on the Save File
button. This will allow you to save the exam submission to disk. You can then email it to us and we will
have the exam graded for you.

In both cases, saved to disk and emailed, or submitted automatically online, once the exam has been graded,
you will be sent an email with your exam results. The results email will be sent to the email account which
you have provided. Once the exam has been evaluated, the grade will be posted to your “My Account”
page which can be accessed from the link on the left hand side of the Resource Centre main page. Once in
the “My Account” area click on the “Marks” link. A listing of your grades for each module completed
will appear.

We hope this guide has been helpful to you and that your system is now set and ready to go to take

your online exams. If you experience difficulties, refer to the troubleshooting section for helpful tips
on common errors that may arise while attempting to get online exams set up.

If you need further assistance please call the Student Support Centre at
1-888-553-5333.
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Troubleshooting some common errors that may occur during setup

1. Webpage runtime error 13 appears when viewing the list of available modules
on the website.

This error occurs when you do not have your Regional Settings set to US English, or you have alternative
language character sets installed on your computer. You need to disable these, and set your Regional
Settings to US English by going into the Control Panel, selecting Regional Settings, and choosing US
English from the drop down list.

2. Pop up for installing exam does not come up when exam module selected.

If you do not receive the prompt to install Active X Controls, confirm that your pop-up blocker is turned
off. If this setting is correct, and you still do not receive the prompt, you may need to change the security
settings regarding Active X Controls in your Internet Explorer browser. Go to the “Tools” menu. Select
“Internet Options” and click on the “Security” tab. Ensure that it is set to MEDIUM. Go to the Privacy
tab and ensure that it is set to MEDIUM as well. Go back to the main webpage, and select the “Final
Exams” link and then the “Select Module” link. This time after selecting the desired module, you should
be prompted to install Active X Controls.

If you are still not prompted to install active X controls, you will need to clean your browser cache,
history, cookies, as well as delete all offline content or delete files created by Add-Ons. The best way to
accomplish this is to use the Delete All option in Tools ->>> Internet Options - >> General and be sure to
check the box for deleting offline content or Add-ons when prompted to confirm this delete all action..
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